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Product documentation
Security Center includes the following documentation:
• Security Center Release Notes. Describes the release in detail, including new features, resolved issues, 

known issues, and limitations.
• Security Center Installation and Upgrade Guide. Describes the prerequisites for installing Security Center, 

and provides instructions for installing and upgrading Security Center on your system.
• Security Center Administrator Guide. Provides all the instructions and conceptual information you’ll need 

to set up, configure, and administer your Security Center system.
• Getting Started with Security Desk. A task-oriented introduction to Security Desk that uses real-world 

scenarios (viewing a camera, searching/exporting video, and managing alarms) to show new users how to 
use the basic product features.

• Genetec Security Desk User Guide. Provides the instructions and conceptual information you need to get 
started with Security Desk, to monitor and generate reports for AutoVu LPR, Omnicast video surveillance, 
and Synergis access control systems.

• Security Center Video Unit Configuration Guide. Provides the pre-configuration instructions for integrating 
video units into Security Center, and any configuration steps required for some video unit features to work.

• Security Center Portable Archive Player User Guide. Explains how to use the Portable Archive Player to 
view exported video files.

• AutoVu Patroller Release Notes. Describes the AutoVu Patroller release in detail, including new features, 
resolved issues, known issues, and limitations.

• AutoVu Hardware Release Notes. Describes the AutoVu Hardware for this release in detail, including new 
features, resolved issues, known issues, and limitations.

• AutoVu Handbook. Provides AutoVu installers and administrators with a single source of information about 
installing and configuring AutoVu hardware and software.

• AutoVu Patroller User Guides. Quick reference guides to using Patroller, AutoVu’s mobile LPR solution. 
There is a separate user guide for each Patroller installation type (Law Enforcement, City Parking 
Enforcement, City Parking Enforcement with Wheel Imaging, University Parking Enforcement, and Mobile 
License Plate Inventory).

• AutoVu Connecting the Sharp Camera. Explains how to power up and connect your Sharp. A printed 
version is provided in the Sharp box.

• AutoVu Connecting the SharpX Camera. Explains how to power up and connect your SharpX. A printed 
version is provided in the SharpX box.

• Plugin User Guides. Introduces you to the plugin features and describes what’s new in the current release. 
It also explains how to install and configure the plugin in Security Center, and how to use it in Security Desk.

Where can I find the product documentation?
• Product DVD. The documentation is available on the product DVD in the Documentation folder. Release 

notes and installation guides include a direct link to the latest version of the document.
• Genetec Technical Assistance Portal (GTAP). The latest version of the documentation is available from 

GTAP. Note, you’ll need a username and password to log on to GTAP.
• Online help. Security Center client applications include online help, which explain how the product works 

and provide instructions on how to use the product features. Patroller and the Sharp portal also include 
context-sensitive help for each screen. To access the online help, click Help, press F1, or tap
the ? (question mark) in the different client applications.

 



Technical support
Genetec Technical Assistance Center (GTAC) is committed to providing its worldwide clientele with the best 
technical support services available. As a Genetec customer, you have access to the Genetec Technical 
Assistance Portal (GTAP), where you can find information and search for answers to your product questions.
• Genetec Technical Assistance Portal (GTAP). GTAP is a support website that provides in-depth support 

information, such as FAQs, knowledge base articles, user guides, supported device lists, training videos, 
product tools, and much more.
Prior to contacting GTAC or opening a support case, it is important to look at this website for potential fixes, 
workarounds, or known issues. You can log in to GTAP or sign up at https://gtap.genetec.com.

• Genetec Technical Assistance Center (GTAC). If you cannot find your answers on GTAP, you can open a sup-
port case online at https://gtap.genetec.com. For GTAC's contact information in your region see the Contact 
page at https://gtap.genetec.com.
NOTE Before contacting GTAC, please have your System ID (available from the About button in your client 
application) and your SMA contract number (if applicable) ready.

• Licensing. 
 For license activations or resets, please contact GTAC at https://gtap.genetec.com.
 For issues with license content or part numbers, or concerns about an order, please contact Genetec 

Customer Service at customerservice@genetec.com, or call 1-866-684-8006 (option #3).
 If you require a demo license or have questions regarding pricing, please contact Genetec Sales at 

sales@genetec.com, or call 1-866-684-8006 (option #2).

Additional resources
If you require additional resources other than the Genetec Technical Assistance Center, the following is available 
to you:
• GTAP Forum. The Forum is an easy to use message board that allows clients and Genetec staff to communi-

cate with each other and discuss a variety of topics, ranging from technical questions to technology tips. You 
can log in or sign up at https://gtapforum.genetec.com.

• Technical training. In a professional classroom environment or from the convenience of your own office, 
our qualified trainers can guide you through system design, installation, operation, and troubleshooting. 
Technical training services are offered for all products and for customers with a varied level of technical 
experience, and can be customized to meet your specific needs and objectives. For more information, go to 
http://www.genetec.com/Services.
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Portable Archive Player User Guide
This guide explains how to use the Portable Archive Player to view exported video files.

The document includes the following topics:

• "Introducing the Portable Archive Player" on page 2
• "The Portable Archive Player user interface" on page 3
• "Playing files in Portable Archive Player" on page 9
• "Check for video tampering" on page 13
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Introducing the Portable Archive Player

This section includes the following topics:

• "About the Portable Archive Player" on page 2
• "How to get the Portable Archive Player" on page 2

About the Portable Archive Player 
The Portable Archive Player is a stand-alone media player used to playback Genetec G64 
video files on computers that do not have Security Center software installed. No software 
installation is required, simply copy the application to your computer and click to open.

You can use the Portable Archive Player to share video clips with someone who does not 
have Security Desk. For example, you could export video evidence to give to a police officer 
and include the Portable Archive Player so that the exported files can be played. 
In addition to playing back Genetec video files, you can also validate video watermarks to 
ensure that the recordings are intact and have not been subject to tampering.

How to get the Portable Archive Player
The Portable Archive Player is not “installed” in the traditional sense. Rather, you simply 
copy the application to your computer and click to open.

There are two ways that the Portable Archive Player can be copied to your workstation:

• Copy it from the Security Center 5.1 installation medium (DVD or downloaded zip 
package). It can be found in the path: \Tools\Portable Archive Player\

• Download it from Genetec using the following URL:
http://downloads.genetec.com/SecurityCenter/5.1/SR3/Tools/PortableArchivePlayer/
PortableArchivePlayer.exe

To uninstall it, delete the executable file.
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The Portable Archive Player user interface

This section describes the main components of the Portable Archive Player user interface.

This section includes the following topics:

• "About the Portable Archive Player’s interface" on page 3
• "About the Main menu" on page 4
• "About the Main toolbar" on page 5
• "About the File browser and Results pane" on page 6
• "About the Playback pane and Tool pane" on page 7
• "Move, resize and show/hide panes" on page 8

About the Portable Archive Player’s interface
The Portable Archive Player main window includes the following areas: main menu and 
toolbar, file browser, playback pane, tool pane, results pane. Each area can be resized or 
hidden, except the playback pane, depending on your workspace needs.

A

B

C

D

E

F

 



4 genetec.com | Security Center 5.1 | Archive Player User Guide 5.1
EN.500.008-V5.1.C3(1)

Portable Archive Player User Guide | The Portable Archive Player user interface

About the Main menu
The Portable Archive Player’s main menu is a standard Windows menu. The View menu, 
the Tools - Options menu, the Help menu, are all found here. Menus support keyboard 
shortcuts. Certain commands, such as changing the visual options, are only available 
through the menu.
Tools - Options - Visual will open the Visual elements dialog box:

A Main menu. See "About the Main menu" on page 4.

B Main toolbar. See "About the Main menu" on page 4.

C File browser. See "About the File browser and Results pane" on page 6.

D Playback pane. See "About the Playback pane and Tool pane" on page 7.

E Tool pane. See "About the Playback pane and Tool pane" on page 7

F Results pane. See "About the File browser and Results pane" on page 6.
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About the Main toolbar
The Portable Archive Player’s main toolbar contains buttons that you can click to access the 
most frequently used commands in the Portable Archive Player. 

B

A

C D

A Pattern Change the tile layout. For more information, see "Change the tile 
pattern" on page 8.

B Volume If your recording contains audio, move the slider to the right to 
increase the volume, or to the left to decrease the volume.

C Expand Click Expand to make the current tile fill the playback pane. A green 
LED appears when the current tile is expanded. Click again to return to 
the original tile size.

D Remove Remove the selected playback sequence from the current tile.
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About the File browser and Results pane
You use the file browser to navigate to the folder containing the G64 video files. The results 
pane displays the contents of the folder you selected in the browser.

By default, the results pane displays only the file names. You can display additional file 
properties include the beginning date/time, the ending date/time, the length and the status 
of the video file. Status refers to whether the video file contains watermarks.

To display the additional file properties, do one of the following:

• Click the Get file info button ( ) to display the properties of the selected file.
• Click the Always get file info button ( ) to display the properties of all files 
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About the Playback pane and Tool pane
The playback pane is where you view video clips. You can view up to 16 playback sequences 
simultaneously. 
NOTE  The Portable Archive Player does not support multiple monitors on a single 
workstation.

The tool pane contains a series of tabs which provide additional information about the 
selected playback sequence that you are viewing. 

The following table gives a brief description of each tab.
Icon Name Description

Properties

View information regarding the selected playback sequence
The Capabilities section shows the playback capabilities of the 
selected sequence. Unsupported capabilities may cause certain 
commands to be disabled in the playback controls. 
The Playback statistics section displays the current bit rate, frame 
rate and video dimensions (resolution).

Digital Zoom Apply digital zoom to the recorded video sequence.

Metadata View the metadata events (if any) associated to the recorded video 
sequence.
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Move, resize and show/hide panes
Panes containing a title bar (such as the Tool pane) can be made into a floating window by 
clicking on the  button, or closed by clicking on the  button. 

To resize any of the panes, click on one of the edges separating two panes and drag it in the 
direction you want to resize. All of the panes can be shown or hidden by placing or 
removing check marks in the View menu except the playback pane which is always shown.

Change the tile pattern
You can choose how many tiles are displayed in the playback pane by clicking the change 
pattern button in the main toolbar.

1 Click the Pattern button on the main toolbar.
2 In the Change pattern dialog box, choose a tile pattern with one, four, nine or sixteen 

tiles in the layout.

There are many different patterns to choose from. If you do not see the pattern you 
want, click More to see the rest of the available patterns.
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Playing files in Portable Archive Player

This section includes the following topics:

• "Play video files" on page 9
• "Using playback controls" on page 9
• "About the Timeline" on page 11
• "Add time range markers" on page 11

Play video files
To play G64 video files in the Portable Archive Player:
1 Launch the application by double clicking on the file Archive Player.exe
2 From the file browser, navigate to, and select the folder containing your exported G64 

files.
The results pane (at the bottom of the interface) displays the G64 files in the folder you 
selected.

3 In the results pane, select a file and double-click or drag it to the playback pane.
The video sequence plays back in your playback pane.

Using playback controls
The Portable Archive Player playback controls are at the bottom of the playback pane and 
include the following features:

A Speed selector Drag the speed selector to the right to fast forward (1x, 2x, 
4x, 6x, 8x, 10x, 20x, 40x and 100x) or to the left for reverse 
playback. You must hold the left mouse button down to keep 
the desired speed. The moment you let go the mouse button, 
the slider will return to normal speed (1x). The playback 
speed is displayed in the status panel.

B Play/Pause Switch between play and pause. The current status appears 
in the status panel.

C Status panel Displays the date/time, playback status and speed. 

D HGFH I J K

BA C
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D Lock/unlock playback speed Enable the speed lock to avoid holding the speed selector 
with the left mouse button. The green LED indicates that the 
feature is enabled. 

E Slow/normal playback speed Play the video in slow motion by enabling slow playback 
speed. The green LED indicates that the feature is 
enabled.The color of the speed control slider will change. 
The available slow motion speeds are 1/8x, 1/4x, 1/3x, 1/2x 
and 1x. 
If the speed is not locked, while in slow motion mode, the 
default playback speed is 1/8x . Note that slow motion 
rewind is not supported.

F Enable/disable loop mode Set the playback to loop continuously within a specific time 
range. The green LED indicates that the feature is enabled. 
For more information, see "Add time range markers" on 
page 11.

G Go to previous key frame Pause the sequence and back up frame by frame.
If you are playing video that was recorded using the MPEG-4 
or H.264 video formats, this button will display the previous 
key frame. Otherwise, this button will display the previous 
frame.

H Go to next frame Pause the sequence and advance frame by frame 

I Save a snapshot Save a snapshot of the current frame to disk.
The snapshot can be saved in BMP or, JPEG format.
On the saved snapshot, the date and time when the frame 
was recorded, followed by the camera name appear in an 
overlay.

J Print a snapshot Print a snapshot of the current frame. Just like a saved 
snapshot, the printed image is stamped with the recording 
date and time, followed by the camera name.

K Export current sequence Export part of the G64 recording file as a shortened G64 file. 
It can also be used to convert the sequence to either AVI or, 
ASF formats.
You can use the time range markers to mark the range in the 
clip you want to export.
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About the Timeline
The timeline looks like a time ruler and is a graphical representation of the selected 
playback sequence. 

Add time range markers
The time range markers are the two orange triangles that appear at the top right corner on 
the timeline when the mouse cursor hovers over the timeline.

You can use these markers to delimit a specific range in the timeline, either to zoom in to it 
or to setup a playback loop.

NOTE  When markers are not in use they do not appear on the timeline. You have hover your 
mouse over the timeline to make them appear.

To set up a time range:

1 In the Playback pane, select the video clip you want to mark.
2 Hover your mouse over the timeline and drag the markers to the desired start and end 

positions.

A Playback cursor Indicates the point of playback on the timeline.

B Motion bar Indicates the presence and level of motion.

C Time range markers Marks a specific range of interest.

D Zoom in Zoom in on a portion of the timeline. You can also use 
Shift + slash (/) to zoom in.

E Bookmark Indicates a user-added bookmark in the clip

F Duration Indicates the duration of the timeline

G Zoom out Zoom out on a portion of the timeline. You can also 
use Shift + asterisk (*) to zoom out.

A C D

GF

B

E

Reset markersTime range markers
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Setup a playback loop
You can create a playback loop to review the same sequence repeatedly:
1 Mark the time range sequence with the time range markers.
2 Position the playback cursor between the two markers.
3 Click on the Enable loop playback button.

4 Click the Play button. 
The marked time range will now play in a continuous loop until you click the Disable 
loop playback button. This will not stop the playback but it will simply turn off the 
playback loop.

5 To clear the time range, click on the Reset markers button.
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Check for video tampering

Video watermarking ensures that your video recordings have not been tampered with. You 
can validate the watermarks to ensure that the recordings are intact from the results pane of 
the Portable Archive Player.

1 Using the file browser, navigate to the folder containing your exported G64 file(s).
2 Select the file(s) that you want to validate

Multiple selections are supported. Use Ctrl + click or, Shift + click 
3 Click  to validate the watermark.

Portable Archive Player analyses the files to determine whether tampering has 
occurred. The status field displays the progress of the validation or the result of the val-
idation.
The results appear in the Status field. The possible results are:

   File watermarked and authenticated

   File tampered at <date and time> where the date and time shown correspond 
to the first video frame that did not pass the validation

NOTE  Not all video recording contain watermarks. When you export a video clip, you can 
choose whether the exported G64 file is created with or without watermarks.

 


